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 Legal Notices 
 

ContentWatch, Inc. makes no representations or warranties with respect to the contents or use of this 
documentation, and specifically disclaims any express or implied warranties of merchantability or fitness for any 
particular purpose. Further, ContentWatch, Inc. reserves the right to revise this publication and to make changes 
to its content, at any time, without obligation to notify any person or entity of such revisions or changes. 

Further, ContentWatch, Inc. makes no representations or warranties with respect to any software, and specifically 
disclaims any express or implied warranties of merchantability or fitness for any particular purpose. Further, 
ContentWatch, Inc. reserves the right to make changes to any and all parts of ContentWatch software, at any 
time, without any obligation to notify any person or entity of such changes. 

You may not use, export, or re-export this product in violation of any applicable laws or regulations including, 
without limitation, U.S. export regulations or the laws of the country in which you reside. 

Copyright © 2005-2010 ContentWatch, Inc. All rights reserved. No part of this publication may be reproduced, 
photocopied, stored on a retrieval system, or transmitted without the express written consent of the publisher. 

 

U.S. Patent No. 745,591. Patents Pending. 
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ContentWatch Trademarks 

ContentProtect is a trademark of ContentWatch, Inc. in the United States and other countries. 

ContentProtect Professional is a trademark of ContentWatch, Inc. in the United States and other countries.  

ContentWatch is a trademark of ContentWatch, Inc. in the United States and other countries. 

Net Nanny is a trademark of ContentWatch, Inc. in the United States and other countries. 

 

Third-Party Materials 

All third-party trademarks are the property of their respective owners. 
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 Welcome to Net Nanny  
 
 

Welcome to Net NannyÊ, the most comprehensive and easily adaptable Internet filtering software available 
today. Net Nanny comes preset to protect you from objectionable and inappropriate content. However, because 
not all users are alike, Net Nanny also allows you to modify the filter settings so you can customize Net Nanny to 
suit your individual usage needs. 

The following resources are available to help you use Net Nanny: 

 ̧ Net Nanny User Guide (PDF format) is available from the Net Nanny Help menu. It provides:  

o Step-by-step instruction 

o Net Nanny category list with descriptions 

o Glossary and FAQ (Frequently Asked Questions) 

 ̧ ContentCleanup User Guide (PDF format) 

Note:  ContentCleanup is available only with the Net Nanny Home Suite. 

 ̧ An online help system is available from the Net Nanny Help menu. It provides step-by-step instruction 
and Web-based reporting. 

 ̧ Customer Support is provided at 1-800-485-4008 for questions and technical assistance. Customer 
Support is available Monday through Friday, 8 a.m. to 5 p.m., Mountain Time. Web-based Customer 
Support is available any time at www.netnanny.com/support or by email at support@contentwatch.com. 

Documentation Conventions 

A trademark symbol (
®

,Ê, etc.) denotes a ContentWatchÊ trademark. An asterisk (*) denotes a third-party 

trademark. 

http://www.netnanny.com/support
mailto:support@contentwatch.com
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 System Requirements and Key Features 
 
 

This section describes the prerequisites that must be met for Net NannyÊ to work properly. It also describes 
some of the key features. 
 
System Requirements 

 Microsoft* Windows* 7/Vista/XP (32-bit and 64-bit) 

 128 MB RAM minimum, 256 MB recommended 

 80 MB hard drive space 

 Minimum screen resolution of  800x600 

 Internet connection 

Key Features 

 User-friendly interface 

 Fast client-based filtering 

 Filtering of encrypted (SSL) web sites 

 Filtering of secure proxy sites 

 Blocking of local host proxy applications 

 PC game management using ESRBÊ ratings 

 Remote user management 

 Keyword blocking (user-defined) 

 Post blocking (block forum posts, blog posts, image uploads) 

 Client and Web IM monitoring and alerting 

 Profanity masking 

 Web and client based graphic reports 

 Social network profile reporting 

 Customizable ñSafe Site Listò capability (whitelist) 

 Alerts for IM predator and cyberbully behavior 

 Email notifications 

 Easy user creation with age-based profiles 

 Instant override and override request options 

 Detection and removal of unwanted content from your computer (Net Nanny Home Suite only) 
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 Installing Net Nanny 
 
 

Important: You must be connected to the Internet to install Net NannyÊ.  

To install Net Nanny: 

1. Double-click the Net Nanny Installer icon  to launch the installation. 

2. From the drop-down menu, select the language you prefer to use during setup and installation, then click 
OK. 

 
 

3. When the Net Nanny Setup Wizard launches, close all other applications before continuing with the 
installation (as recommended), then click Next to continue. 

 
 



 

 

ContentWatc h, Inc. / Net Nanny User Guide  
       Page 10 

4. Carefully review the License Agreement, select I accept the agreement, then click Next to continue.  

 
 

5. Type in your registration number, then click Next to continue.  

If you purchased Net Nanny online or requested a trialware number, the registration number was sent to 
you via email. If you purchased Net Nanny in a store, the registration number came with your CD.  

 
 
If Net Nanny is unable to contact the ContentWatch registration server, a message displays reminding 
you to verify that your firewall is disabled and asking if you want to configure proxy server settings. 
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You can attempt to connect to ContentWatch via a proxy server provided that the following criteria are 
met: 

 You have verified that your firewall is disabled. 

 You have verified that your Internet connection is working (that is, your computer is able to connect 
to your Internet Service Provider; for example, you can load your home page). 

 Your ISP offers a proxy server as an alternate means of connecting to the Internet. 

 

To configure proxy settings: 

a) Obtain the necessary proxy server information, such as hostname and port number, from your 
ISP. 

b) At the prompt asking you if you want to configure proxy server settings, click Yes. 

 

c) In the Proxy Configuration screen, provide proxy server information as specified by your ISP, 
then click OK. 

 

 

6.  (Conditional) If you are installing and registering Net Nanny for the first time, skip to Step 8. 
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7. (Conditional) If you purchased multiple Net Nanny licenses and are now installing an additional instance 
of the Net Nanny client, or if you only have one license and you are reinstalling Net Nanny, do the 
following: 

a. Type the email address and password you used to initially register Net Nanny. 

 
 

b. Click Next. 

c. Skip to Step 11. 

 

8. Type your email address, then click Next to continue.  
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9. Assign the password you want to use for the Net Nanny administrator account, then click Next to 
continue. 

Passwords are case sensitive and are limited to between 3 and 13 characters in length. Alpha and 
numeric characters can be combined. 

 
 
10. Select a secret question, provide an answer, then click Finish. 

 
If you ever forget your password, Net Nanny prompts you with the secret question you chose. You must 
enter the correct answer before Net Nanny allows you to change the administrator account password. 
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11.  Accept the default destination folder for the Net Nanny installation (or click Browse to select an alternate 
installation folder), then click Next. 

 
 

12. Click Install. 

 

 

13. Do one of the following: 

 To set up one or more user accounts now, select Help me create users now, then continue with 
step 14. 

 Select Use the default settings, then skip to step 15.  
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14. (Conditional) If you chose to set up users, follow these steps: 

a. Make sure Help me create users now is selected, then click Next. 

  

 

b. Click Add. 
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c. Type a username and password, then type the password again to confirm it. 

d. Select a profile type based on the userôs age, then click OK. 

 

 

e. Repeat steps 14b-14d until all of your users have been created, then click Next. 
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15. Click Finish to restart your computer and complete the Net Nanny installation and setup. 

Warning: Although you have the option to restart your computer later, Net Nanny will not begin 
protecting your computer until after you have restarted. 

 

Your computer automatically shuts down and restarts. 
 

After your computer restarts, a Net Nanny icon  appears in the system tray at the bottom of your Windows 
desktop. 
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 The Net Nanny Systray Icon 
 
 

The Net NannyÊ icon  in the Windows system tray gives you quick right-click access to the following:  

 Admin Tools  

 Login or Logout user 

 Refresh profiles 

 Remote management 

 Extend time (when time controls are enabled) 

 Change password 

 Help 

 Enable or disable Net Nanny 

 Check for updates 

 About 

 

If you would like to prevent users from accessing Net Nanny features using the systray icon, you can select to 
temporarily remove the icon from the system tray. 

Note to Windows 7 users: After installing Net Nanny, Windows 7 automatically places the Net Nanny systray 
icon in the hidden icons group. To access the Net Nanny icon, click the hidden icons expander button to the left 
of the system tray. 

 

You can move the Net Nanny icon to the main system tray area by clicking Customize in the hidden icons group 
box, locating the cwtray.exe item in the icons and notifications settings list, and choosing to ñShow icon and 
notificationsò for that item. 

 

Net Nanny systray icon 
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Removing and Displaying the Net Nanny Systray Icon 

To remove or display the Net Nanny systray icon: 
 

1. Click Start > Programs > ContentWatch > Net Nanny.  

2. Log in to Admin Tools with an administrator name and password. 

3. From the Tools menu, select Hide Systray Icon to remove or display the Net Nanny icon. 

If a check mark appears to the left of the Hide Systray Icon option, the Net Nanny systray icon is 
removed from the system tray. Conversely, if there is no check mark, the Net Nanny systray icon is 
displayed. 
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 Signing In to Net Nanny 
 
 

Net NannyÊ is automatically installed with a default user. This means that all users are able to access the 
Internet and instant messaging as one Net Nanny user, using the default userôs settings. The default user 
provides ease-of-use; however, it does not separately monitor each userôs Internet usage, and filters are 
unilaterally applied to all users.  

You can create separate user profiles for each person who uses the computer. Individual users must sign in to 
their Net Nanny accounts before they are able to use the Internet for browsing or instant messaging. This allows 
Net Nanny to monitor each userôs Internet usage and block content on a per-user basis.  

 
 
You must sign in to Net Nanny before you can access the Internet or instant messaging. If you do not sign in 
manually, you are prompted to sign in when you attempt to use the Internet. 

To sign in manually: 

1. Right-click the Net Nanny icon  in the system tray at the bottom of your Windows desktop, then select 
Login from the quick menu.  

 
 

Note: If you do not see the Net Nanny icon in the system tray, the icon may be removed. For instructions 
on displaying the icon, see Removing and Displaying the Net Nanny Systray Icon on page 19. 
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2. Select your username from the drop-down menu, enter your password, then click OK.  

If you donôt know your password, ask the administrator. 

Note: Bullets appear as you type your password to protect it from being viewed. 

  

You are now signed in as a user. Launch your Internet browser and proceed with regular Internet activity. For 
information about the possible block and warning messages you might receive, see Block and Warning 
Responses on page 49.  
 
When you finish your Internet or instant messaging session, we recommend you sign out of Net Nanny.  
 
Warning: If you leave your computer without signing out of Net Nanny, other users have access to the Internet 
under your sign-in name and also to your Web and instant message privileges. Besides continuing to log Internet 
usage time under your name, Net Nanny also continues to log Web and instant message activity under your 
name. However, if Inactive User Logout is enabled, you are automatically logged out according to the time 
settings configured by the administrator.  
 
To sign out of Net Nanny: 

1. Right-click the Net Nanny icon  located at the bottom of your Windows desktop. 

2. Select Logout <username> from the quick menu.  

 
 
Note: If you shut down your computer without signing out, your session automatically ends. You must sign in 
again when the computer restarts. 
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 Updating Net Nanny with Online Updates 
 
 

Online updates allow you to update Net NannyÊ with the latest software updates. There are three methods for 
receiving update notifications for Net Nanny: Manual (default), Automatic, and Password Protected. 

Manual Updates 

To configure Net Nanny for manual updates:  

1. Sign in to Net Nannyôs Admin Tools. 

For instructions on how to do this, see Opening the Net Nanny Admin Tools on page 30.  

2. From the Tools menu, select Updates. 

The following dialog window appears: 

 

3. In the Updater Settings dialog, select Let me check for updates manually or Require a password to 
check for updates, depending on whether you want to require a password for a user to check for 
updates, then click OK. 

4. Close the Admin Tools. 

 

To manually update Net Nanny: 

1. Right-click the Net Nanny icon  in the system tray. 

Note: If you do not see the Net Nanny icon in the system tray, the icon may have been removed. For 
instructions on displaying the icon, see Removing and Displaying the Net Nanny Systray Icon on 
page 19. 

2. Select Check For Updates from the quick menu. 
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3. At the ContentWatch Updater screen, click Next. 

  

If there are no new updates, Net Nanny indicates that none are available.  

If Net Nanny updates are available, a wizard appears and steps you through the process of downloading 
and installing the updates. If you choose to download and install the updates, you may be asked to 
restart your computer for the changes to take effect. 

 

Automatic Update Notification 

To configure Net Nanny to automatically notify you when a new update is available:  

1. Sign in to the Net Nanny Admin Tools. 

For instructions on how to do this, see Opening the Net Nanny Admin Tools on page 30. 

2. From the Tools menu, select Updates. 

The following dialog window appears: 
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3. In the Updater Settings dialog window, select Notify me when updates are available but donôt 
automatically download or install them, then click OK. 

Net Nanny is now configured to notify you when updates are available. 
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Password-Protected Updates 

To require an administrative password in order to check for Net Nanny updates:  

1. Sign in to the Net Nanny Admin Tools. 

For instructions on how to do this, see Opening the Net Nanny Admin Tools on page 30. 

2. From the Tools menu, select Updates. 

The following dialog window appears: 

 

3. Select Require a password to check for updates, then click OK. 

4. Close the Admin Tools. 
 
Net Nanny is now configured to prompt for a Net Nanny administrator password whenever a user attempts to 
manually update the software. 
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Installing Filter Definitions 

A filter definition determines how content is recognized and matched against filters. Automatically downloading 
and installing filter definitions ensures that Net Nanny is always kept current with the latest definition files. 

To set the filter definitions to update automatically: 

1. Sign in to the Net Nanny Admin Tools. 

 For instructions on how to do this, see Opening the Net Nanny Admin Tools on page 30. 

2. From the Tools menu, select Updates. 

The following dialog window appears: 

 

3. In the Updater Settings dialog, select Download and install filter definitions automatically, then click 
OK. 
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 Changing User Passwords 
 
 

If permitted in their Net Nanny profile settings, users can quickly change their own Net NannyÊ login passwords. 

To change a password: 

1. Make sure you are logged in to Net Nanny with your own username. 

2. Right-click the Net Nanny icon  in the system tray. 

3. Select Change Password from the quick menu. 

  

4. Type the old password and the new password in the appropriate fields, retype the new password to 
confirm it, then click OK. 
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 Disabling Net Nanny  
 
 

There may be times when you want to temporarily disable Net NannyÊðfor example, you might want to 
temporarily allow access to the Internet without blocking any content. Rather than temporarily changing the 
current userôs policies, you could temporarily disable Net Nanny. 

To temporarily disable Net Nanny 
 

1. Right-click the Net Nanny icon  in the system tray. 

 Note: If you do not see the Net Nanny icon in the system tray, the icon may be hidden. For instructions 
on displaying the icon, see Removing and Displaying the Net Nanny Systray Icon on page 19. 

2. Select Disable Net Nanny from the quick menu. 

  
 
3. Type the administratorôs password, then click OK. 
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4. Choose to have the client automatically re-enable itself or remind you that it is disabled after a certain 
amount of time has passed. 

 

5. From the drop-down list, select the amount of time until the client re-enables itself or reminds you that it 
is disabled, then click OK. 

Net Nanny is now disabled. Notice that the Net Nanny systray icon changes  to indicate a disabled 
status. 

 

To re-enable Net Nanny: 

1. Right-click the Net Nanny icon in the system tray. 

2. Select Enable Net Nanny from the quick menu. 
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 Introduction to the Net Nanny Local Admin Tools 
 
 

You must have an administrator account to open Net NannyÊ Admin Tools. Within these tools, you can 
customize user profiles, define filter settings, and monitor user activity. 

Opening the Net Nanny Admin Tools 

To open the Net Nanny Admin Tools: 

1. Right-click the Net Nanny icon  in the system tray at the bottom of your Windows desktop, then select 
Admin Tools from the quick menu.  

 Note: If you do not see the Net Nanny icon in the system tray, the icon may be hidden. For instructions 
on displaying the icon, see Removing and Displaying the Net Nanny Systray Icon on page 19. 

 

You can also click Start > Programs > ContentWatch > Net Nanny or, if you are the user who 
installed Net Nanny, you can double-click the Net Nanny icon on the desktop. 

2. Select your administrator name from the drop-down menu, type your password, then click OK.  

 

Bullets appear as you type your password to protect it from being viewed. 

Note: If you cannot remember your administrator password, click Forgot Password? Your Web browser 
launches and takes you to the ContentWatch Web site, where you are asked to enter the email address 
you specified when installing Net Nanny. An email is then sent to this address with a link to a Web page 
that asks you the secret question you entered when you installed Net Nanny. Correctly type the secret 
answer, and you are then allowed to change your password for this account. 
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 Once you have logged in, the Net Nanny Admin Tools window appears: 

  
 
Important: We recommend that you do not leave the Net Nanny Admin Tools open if you walk away from your 
computer, because other users would have full access to all the programôs administrator settings. 

Closing the Net Nanny Admin Tools 

To close the Net Nanny Admin Tools, click File > Exit.  

 
 
Note: Closing the Net Nanny Admin Tools does not disable Net Nanny. User accounts, profiles, and content 
filters are still active. 
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Overview of the Net Nanny Admin Tools Interface 

The following is an overview of the layout of the Net Nanny Admin Tools interface. Details about how to use the 
Admin Tools to configure specific settings are provided in subsequent sections of this user guide.  
 

   

User Settings 

 
Individual usersô 

profile information 

and Internet access 
settings are 

configured here. 

Family Settings  
 

Settings that apply 

globally to all users 

are configured here. 

User List 
 

Users are added 
and removed here. 

Menu Bar 
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 Setting the Time Zone 
 
 

To ensure that the Net NannyÊ time-related features (such as Time Controls and Reports) work correctly, you 
must specify your time zone. To set the time zone: 

1. Sign in to the Admin Tools.  

2. From the Tools menu, select Time Zone, or select Set time zone in the Admin's Settings section of the 
Net Nanny Admin Tools interface. 

  

 The Time Zone dialog appears. 

  

 
3. From the drop-down list, select your time zone, then click OK. 
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 Managing User Profiles 
 
 

A user profile is an account created for a system user. The user profile can be used to apply custom filters to 
individual users and to track each userôs Internet usage.  

Net NannyÊ is automatically installed with a default user profile. This means that all users are able to access the 
Internet and instant messaging as one Net Nanny user, using the default userôs settings. The default user profile 
provides ease-of-use; however, it does not separately monitor each userôs Internet usage, and filters are 
unilaterally applied to all users.  

You can also create separate user profiles for each person who uses the computer so that individual users must 
sign in to their own Net Nanny accounts before they are able to use the Internet for browsing or instant 
messaging. This allows Net Nanny to monitor each userôs Internet activities and block content on a per-user 
basis. Individual profiles should each have a unique password so users cannot log in to other user accounts. 

You can use both a default user and individual user profiles. However, it is recommended that you use either one 
or the other, depending on whether you want all restrictions to apply equally to all users (default user) or you 
want to be able to monitor each userôs individual activities (individual user profiles). If you use individual user 
profiles, it is also recommended that you delete the default user profile so that users cannot use the default 
profile to circumvent individual user monitoring. 

Using a Default User Profile 

The default user profile that is created when you install Net Nanny makes it possible for all users to log in 
automatically using a single profile. This is useful when you want the same restrictions to apply to all users. The 
default user profile provides the functionality that was delivered by Default Mode in previous versions of Net 
Nanny. 

The default user is set to use auto client login. This means that when a user accesses the Internet, they are 
logged in automatically as the default user. If the default user is the only user profile, all users will have the same 
restrictions. 

If the default user profile is used together with individual user profiles, consider the following: 

 The default user should be the most restricted user. Otherwise, a user with more restrictions than the 
default user can log in as default to circumvent some restrictions. 

 For a user to log in with a different user profile, that user must log out, then log in again with the desired 
user profile. 

Reports for the default user do not show who is specifically responsible for the Internet activities reported. 
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Creating Individual User Profiles 

Net Nanny allows you to duplicate settings from existing user profiles to create new user profiles. When you 
duplicate a user profile, the filter settings and time controls for the selected profile are applied to the new profile.  

To create a new user profile based on an existing profile: 

1. Sign in to the Admin Tools. 

2. Under the Users list, click Add User. 

  

For a detailed description of the options in the Add User dialog, see User Profile Options on page 36.  
 
3. Choose whether to create the new user based on a predefined age profile or on the profile of an existing 

user. 
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To base the new user on a predefined age profile, select Predefined Profile, then select the desired age 
profile from the drop-down list.  

 

To base the new user on an existing user, select Existing User, then select the desired user profile from  
the drop-down list. 

 

 

4. Complete the user information under Profile Settings, then click OK. 

For a description of the options in the Add User dialog, see User Profile Options.  

After you create the user profile, you can define the filter settings and time controls for the user. For more 
information, see Managing Filter Settings on page 40 and Managing Time Controls on page 57. 

5. Repeat this procedure for each user you want to create. 

User Profile Options 

The following table outlines the user profile options: 
 

Field Description 

User Name The name the user enters to sign in to Net Nanny. 

Usernames must be between 2 and 20 characters in length. 

Auto Windows Login Enables Net Nanny to employ a user's Windows login credentials to automatically log 
in to his or her personal Net Nanny profile for Internet access. From the Auto Windows 
Login drop-down list, select the Windows account you want to associate with the user's 
Net Nanny profile. Once this association has been made, the user only has to log in to 
Windows and will not be prompted to log in to Net Nanny separately. 
 
Please be aware that this association is not automatically synchronized to other 
computers in your household. If a family member has Windows accounts on multiple 
computers, you must configure the Auto Windows Login option for that user on each 
computer. 
 
Note: If you set up a user's Net Nanny profile to have the same name as the user's 
Windows account, and you selected the Auto Windows Login option in the Net Nanny 
Remote Management tool on the Web, Net Nanny attempts to create an association 
between the Windows account and the Net Nanny profile upon the first login attempt. 
For example, if the Auto Windows Login option is selected in Remote Management 
and the username "JohnD" exists in the Net Nanny user list, a user who logs in to 
Windows as "JohnD" is automatically logged in to Net Nanny without having to specify 
a Net Nanny username and password the first time he or she logs in to the computer. 

Important: We recommend that filter settings for password-free profiles be more 
restrictive than user profiles that require passwords. 
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Field Description 

Email Userôs email address.  

This field is required only if the user is an administrator. 

Password Userôs password. 

Confirm Password This field appears after you type a password in the Password field. Retype the 
password to confirm that it is typed correctly in the Password field. 

Inactive User Logout Designates an inactivity threshold after which the user is automatically logged out. 

If you select Never, Net Nanny does not automatically log out the user. 

Auto Client Login Enables Net Nanny to remember the profile's username and password and to 
automatically log in to Net Nanny using this profile whenever a user attempts to access 
Internet content. 

When this option is selected, users need to log in to Net Nanny only once. Thereafter, 
Net Nanny no longer prompts for login credentials when users attempt to access 
Internet content, even if the computer is rebooted. Net Nanny continues to remember 
the username and password until someone manually logs off the Net Nanny profile. 

Note: Use the Auto Client Login option when you want to monitor and manage Internet 
activity for a single computer rather than specific users. For example, suppose you 
have a computer in your living room and you want to use the same Net Nanny filter 
settings, time controls, etc., to control Internet access for anyone who uses that 
computer. Create a Net Nanny profile named "Living Room," configure profile settings 
as desired, and then enable the Auto Client Login option so that users automatically 
log in to Net Nanny when they start that computer and try to access the Internet. 

Administrator Gives the user administrative privileges.  

Users with administrative privileges can change passwords, profile settings, and filters; 
receive email notifications; and access reporting and remote management. 

Allow user to change 
password 

Allows the user to change his or her own Net Nanny login password by right-clicking on 
the Net Nanny systray icon.  

Display instant 
override option 

Enables the user to override blocked categories with the override password. The user 
must enter the override password before Net Nanny displays the blocked content. 
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Assigning Administrative Privileges to a User Profile 

The primary administrator account is created during installation. This administrator profile is permanent and 
cannot be changed; however, you can assign administrative privileges to other users.  

To assign administrative privileges to an existing user profile:  

1. Sign in to the Admin Tools. 

2. From the User List, select an existing user, then click Manage Profile.  

3. Select the Administrator option to give administrative privileges to this user.  

  
 
4. Click OK to save the changes. 

Modifying an Existing User Profile 

There may be circumstances when you need to change existing user profiles. For example, you may want to 
change the user password, update a userôs email address, etc.  

To modify an existing user profile:  

1. Sign in to the Admin Tools. 

2. From the User List, select an existing user, then click Manage Profile. 

3. Modify the userôs profile settings, then click OK to save your changes.  

Changing Passwords 

Net Nanny allows administrators to change user passwords without having to provide the userôs current 
password. Passwords prevent unauthorized users from logging in to a user profile that is less restrictive than 
their own. For example, if you do not assign passwords, there is nothing to prevent a child from logging in to an 
older sibling's or parentôs less restrictive user profile. Likewise, without a password, a user can log in to another 
userôs profile to prevent Internet activity from being reported against his or her own user profile. 

To change a userôs password: 

1. Sign in to the Admin Tools. 

2. From the User List, select an existing user, then click Manage Profile. 

3. Type the new password and confirm.  
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Passwords are case sensitive and must be between 3 and 13 characters in length. Numbers and letters 
can be combined.  

4. When finished, click OK to save your changes. 

If you forget the primary administrator password, you can do any of the following: 

 If you have more than one administrator account, another administrator can change your password for 
you by logging in to Admin Tools, selecting the user from the User List, then changing the password in 
the Profile Settings dialog. 

 On the Admin Tools login screen, click Forgot Password. Your Web browser launches and takes you to 
the ContentWatchÊ Web site where you are asked to enter the email address you specified when 
installing Net Nanny. An email is then sent to this address containing a link to a Web page that asks you 
the secret question you entered when you installed Net Nanny. Type the secret answer and you are then 
allowed to change your password for this account. 

 Select Remote Management from the system tray icon and, in the Web page that appears, click Forgot 
Password. You are prompted to enter the email address you specified when installing Net Nanny. An 
email is then sent to this address containing a link to a Web page that asks you the secret question you 
entered when you installed Net Nanny. When you type the secret answer, you are then allowed to 
change your password for this account. 

 Email a Password Request to info@contentwatch.com or call Customer Support at 1-800-485-4008. 
You must provide the following information to change the primary administrator password: 

o Registration key 

o Email address (where to send password) 

o Secret question and answer 

Deleting a User Profile 

Net Nanny allows users with administrator rights to delete existing user profiles. 

Warning: This action cannot be undone. Deleting a user also permanently deletes the userôs activity data. The 
userôs Internet and instant messaging activities no longer appear in reports. If a user profile is accidentally 
deleted, it cannot be restored. If you want to restore the account, you must create it again.  

To delete an existing user profile: 

1. Sign in to the Admin Tools. 

2. From the User List, select an existing user, then click Remove User. 

3. Click OK to confirm the deletion. 

You cannot delete a user who has Admin privileges. Before you can delete an Admin, you must deselect the 
Admin check box for that user. 

 

mailto:info@contentwatch.com
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 Managing Filter Settings 
 
 

Filter settings are used to control Internet activity (Web browsing), instant messaging (Yahoo!, AOL, MSN, QQ, 
Google Talk, MySpace IM), Internet chat, newsgroups, and peer-to-peer access. These services can be 
individually allowed or blocked for each user in the User List. Additionally, you can use filter settings to control 
whether a userôs profile is captured when logging on to a social networking site (such as Facebook, Twitter, 
YouTube, and so on). 

If the Display Instant Override Option setting is selected in the Profile Settings dialog, the user can override 
blocked categories with the override password. The user must enter the override password before Net NannyÊ 
displays the blocked content.  
 
Note: The override password is created during installation and can be changed in the Passwords dialog. 
 
To open the filter settings:  

 
1. Sign in to the Admin Tools. 

2. From the User List, select an existing user profile, then click Filtering.  

The Filter Settings window for the selected user appears. 
 

 

The Filter Settings window contains four tabs: 

Web: Provides settings that let you enable or disable Web browsing, record all activity on the Web, and 
choose whether to filter Web content or allow access to only specified Web sites. If you choose to filter 



 

 

ContentWatc h, Inc. / Net Nanny User Guide  
       Page 41 

Web content, you can specify the access level allowed for a variety of different types of content. This tab 
also lets you configure the message that appears when a site is blocked. 

Instant Messaging: Provides settings that enable you to control instant messaging. For example, you 
can select which IM programs are allowed, whether activity is recorded, and the types of instant 
messaging content that are monitored. 

Social Networking: Provides settings that enable profile reporting for popular social networking sites.  

Additional Settings: Provides advanced settings that give you additional control over Web activity, such 
as whether access is allowed to chat groups, newsgroups, or peer-to-peer networking sites. You can 
also block forum and blog posts, block Internet access for 64-bit applications, and specify whether to 
filter content from secure Web sites (HTTPS). 

 The following sections provide information about each of these tabs. 

Defining Web Settings 

To access the Web tab: 

1. Sign in to the Admin Tools. 

2. From the User List, select an existing user profile, then click Filtering. 

3. If the Web tab is not already selected, click Web. 

 
 
 

The Web tab is divided into four sections: 

Web Browsing: Select Web browsing settings. 

When Blocked or Warned: Configure the way Net Nanny responds when a Web site is blocked or 
triggers a warning. 
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Keyword Blocking: Specify objectionable words or phrases that you want to block users from viewing 
on the Web. When Net Nanny detects any of these words or phrases on a Web page, it blocks users 
from viewing that page.  

Categories: Filter Web content or allow access only to specified sites, depending on your Web browsing 
settings. If you choose to filter content, this section provides filters where you can set the access level for 
a variety of types of content. If you choose to allow access to specified sites, this section lets you set the 
sites that can be accessed. 

Configuring Web Browsing Settings  

The Web tab is divided into four sections. The first section contains Web browsing settings. To set the Web 
browsing settings: 

1. Sign in to the Admin Tools. 

2. From the User List, select an existing user profile. 

3. Click Filtering. 

4. If the Web tab is not already selected, click Web. 

5. Locate the Web Browsing section of the Web tab.  

  

6. To allow users to browse the Web, select Enable Web browsing. 

If Enable Web browsing is not selected, the user cannot access the Web. 

7. If you want Web activity to be recorded so you can monitor it, select Record Web activity. 

8. Select whether to filter Web content or allow access only to specified sites. 

If you select Filter Web content, you can configure the access level for a variety of types of Web 
content. See Defining_User_Filter_Settings for more information.  

If you select Restrict browsing to specific sites, you can configure which sites the user is allowed to 
browse. See Specifying_Allowed_Web_Sites on page 47. 

9. Click OK to save your settings. 

Defining User Filter Settings 

Filter settings determine the level of access users have to the predefined Internet content categories. User 
access to these sites can be set to the following: 

Allow: Provides access without restriction. No message is displayed and the user is allowed access to the 
requested page. The action is logged (if logging is enabled for this user). 

Warn: Provides access but warns the user of the types of content about to be viewed and lists the category 
types that caused the warning. A warning message is displayed and the user can choose to view the 
requested page. The action is logged (if logging is enabled for this user). 

Block: Prompts the user that the Web site is being blocked and lists the category types that have blocked it. 
The requested page does not open unless the user has the privilege to override the block and does so. The 
action is logged (if logging is enabled for this user). Note: For message examples and descriptions, see 
Block and Warning Responses on page 49. 
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To define a userôs filter settings:  

1. Locate the Web Browsing section of the Web tab.  

2. Select Filter Web content.  

The Web content filter Categories appear. 

Note: By default, only the most commonly blocked content categories are displayed. To display the full 
list of available content categories, click Show me all 35 categories. 

 

The following categories are blocked by default: 

 Adult/Mature 

 Alcohol 

 Gambling 

 Hate/Violence 

 Illegal Activities 

 Illegal Drugs 

 Intimate Apparel/Swimsuits 

 Pornography 

 Profanity 

 Proxy 

 Tobacco 

 Weapons 

All other categories are set to Allow, except for Profanity. The Profanity category is set to Mask by 
default to replace objectionable words on filtered Web pages with random characters, leaving all 
remaining content intact. Net Nanny supports masking both US and British profanity. To specify the 
versions of English you want to filter, click Manage languages for profanity masking, select or 
deselect versions of English as desired, then click OK. 

 

For a listing of Net Nanny categories and descriptions, see Content Categories on page 45. 
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3. Do one of the following: 

 Select Allow, Warn, or Block from the drop-down list for each content category whose setting you 
want to change.  

        

 Select a setting from the Reset All Categories To drop-down list, then click OK to change all 
content categories to the same setting. 

        

4. When finished, click OK to apply your settings.  
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Content Categories 

To help you filter Internet content, Net Nanny provides a list of predefined content categories. You can choose to 
Allow, Warn, or Block URLs that fall within these categories.  

Note: For information on defining filter settings, see Defining User Filter Settings on page 42. 

The following table outlines the Net Nanny predefined content categories: 

 

Category Description 

 Adult/ 
Mature 

Contains subject matter intended for mature audiences, such as obscene or vulgar 
language and adult instant message rooms. These sites could be considered R-
rated. 

 Alcohol Contains subject matter that deals with manufacturing, distributing, or obtaining 
alcohol. 

 
Chat Sites Provides access to chat services. 

 Email Provides access to email services and applications. 

 Employment/ 
Career 

Allows the posting of jobs or resumes. Provides information on compensation in 
specific fields or regions. Posts information about jobs and job openings. 

 Family Resources Provides family counseling, family safety tips, parenting information and tips, and 
family planning. 

 Financial/ 
Stocks 

Provides information about finances, financial planning, insurance, stock tickers, and 
stock reports. Allows the sale and purchase of stock. Includes banks and credit 
unions and credit rating and reporting sites. 

 Gambling Allows a person to wager money on online games with the expectation of winning 
money or prizes. Contains links to other gambling sites or provides information on 
gambling strategies or tactics. 

 Games Provides access to online or downloadable games, discussions about games, or 
information about game cheats. 

 Government Provides information specific to local, state, or federal government organizations or 
agencies, including political party sites and specific, official political sites. Sites 
ending in .gov. 

 
Hate/ 
Violence 

Promotes or depicts violence against persons, animals, property, or nations. Singles 
out groups for violence based on race, religion, or creed. 

 Health/ 
Medicine 

Provides information on mental or physical health issues. Allows the online purchase 
of prescription medications. 
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 Illegal Activities Provides information about the manufacture, alteration, or sales of weapons, 
explosives, and explosive devices. Promotes or depicts disorderly conduct . 

 
Illegal Drugs Contains subject matter that deals with manufacturing, distributing, or obtaining 

illegal drugs or other controlled substances. Depicts drug paraphernalia and/or 
includes methods for obtaining or manufacturing them. Does not include sites that 
provide information on prescription medications except those sites that describe how 
to obtain them. 

 
Image/ 
Video Search 

Allows the user to search for images or videos, including Google Images and 
YouTube. 

 Intimate Apparel/ 
Swimsuits 

Displays models wearing underwear, lingerie, or other suggestive or see-through 
attire, including swimsuits. 

 Kids Contains subject matter intended for children, including entertainment, education, 
crisis counseling, and kid-friendly communities. 

 Music/ 
Entertainment 

Provides access to free downloadable or for-pay online music and video files such as 
MP3, WAV, MPG, and AVI. Sells music or videos or is dedicated to the music or 
entertainment industry. Provides information on TV programs and programming, 
including movie review sites. 

 News Provides live, recorded, or written reports or editorials about current events.  

 Other Sites that do not fit into any of the existing Net Nanny categories. 

 Personals/ 
Dating 

Contains personal ads, personal info pages, and personal portals. 

 Pornography Contains subject matter that is meant to sexually arouse the viewer. May show 
models or real people that are engaged in erotic behavior intended to cause sexual 
excitement. May describe sexually explicit activities or contain sexually explicit 
material including images, movies, or text. Sites could be considered X-rated. 

 
Profanity Contains profanity or hurtful language. Set this category to Mask to replace the 

objectionable words on the filtered Web page with random characters, leaving all 
remaining content intact. 

 Proxy Allows users to anonymously surf the Internet, either for the purpose of maintaining 
online privacy or bypassing content filtering software. 

 Reference Contains instructional material, tutorials, or how-to pages. 

 Religious Provides information on specific religions or religious beliefs. Includes regional 
religious organizational sites and sites built to promote religious groups, activities, 
and membership. 
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 Schools/Colleges Contains information dealing with colleges, schools, seminars, or courses. Sites that 
end in .edu. 

 Search Engines/ 
Portals 

Provides mechanisms for searching the Internet by specific words or phrases and 
displays the results as either links or images. Allows a user to customize the look or 
content and is geared to providing a "starting" place on the Internet. 

 Shopping Provides access to online malls, catalogs, or auctions, including classified ads. 
Includes department store sites, retail store sites, or sites that have coupons for free 
or discounted items. 

 
Social Networks Sites related to online communities or social networks. 

 Sports/Recreation Promotes, advertises, reports on, or is associated with sports teams, individuals, or 
organizations. Includes sites that are involved with fantasy sports and organizations 
whose main focus is to report on amateur, college, or professional sports. 

 
Tobacco Intended for the sale or consumption of tobacco. 

 Travel Provides information on travel, such as destination descriptions, ticketing, and 
reservations. Includes airline, bus, or train company sites and car rental sites. 

 Weapons Intended for selling or providing information about using firearms, swords, knives, 
and other weapons. 

 Work Related Allows an organization to add URLs for sites that are used by the organization in the 
course of doing business. It may initially be blank. 

 

 
Note: When Net Nanny is enabled and the Pornography content category is set to Block, it enforces a ñsafe 
searchò for many popular search engines. Currently, Net Nanny can force a safe search for popular search 
engines, such as: Yahoo!, Google, AltaVista*, DogPile*, Lycos*, AllTheWeb*, Bing, and Ask. To bypass the safe 
search, you must temporarily disable Net Nanny via its system tray iconôs right-click menu or set the Pornography 
content category to Allow. 

Specifying Allowed Web Sites 

If you select Restrict browsing to specific sites, the user is only allowed to browse to the sites listed. This is 
sometimes referred to as whitelist mode. You must have at least one site in the list of allowed sites. If no sites are 
listed, the user will not be able to access any Web sites. 

To add a Web site to the list of allowed sites:  

1. Locate the Web Browsing section of the Web tab.  

2. Select Restrict browsing to specific sites.  

The Allowed Sites section containing the Web site list appears in tab's dialog. 
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3. Click Add.  

A blank, editable line appears in the Allowed Sites list. 

4. Type the URL for the site you want to allow.  

5. Repeat steps 3 and 4 for each site you want to add.  

6. Click OK to save your changes.  

After you have added sites to the list, you can select a site and click Edit to change the URL. You can also select 
a site and click Delete to remove it from the Allowed Sites list. 
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Block and Warning Responses 

When you define a userôs filter settings, you determine what level of access that user has to predefined Internet 
content categories. User access to these sites can be set to Allow, Warn, or Block. 

If a user attempts to access a site that falls under a content category that is set to Warn or Block, Net Nanny can 
respond in one of four ways: 

 Display a block or warning dialog 

 Display a Web page saying access to the site is forbidden 

 Display a block or warning Web page 

 Redirect a user to a different Web site 

Displaying Block and Warning Dialogs 

To configure Net Nanny to display block or warning dialogs: 

1. Sign in to the Admin Tools. 

2. From the User List, select an existing user profile, then click Filtering.  

3. In the When Blocked or Warned section on the Web tab, select Block Dialog from the Display drop-
down list.  

 

4. If you want to display the content category (or categories) that caused the block or warning response, 
select Display the reason for being blocked. 

5. If you want to allow the user to request that the page not be blocked in the future, select Allow user to 
request exceptions. 

6. Click OK. 
 
Following are examples of the Block and Warning dialogs Net Nanny displays when users access sites with a 
warning or blocked status. 

Warning Messages 

When a user attempts to connect to a site with a warning status, Net Nanny notifies the user:  

 

The user can click Continue to view the requested page or Back to return to the previous Web page. If enabled, 
the user can click Request Exception to request that the administrator allow access to this site. Any of these 
actions is reported if reporting is enabled. For more information, see Enabling Local Reporting on page 70. 
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Block Messages 

When a user attempts to connect to a site with a blocked status, Net Nanny notifies the user:  

 

The requested Web page does not open. The user can click Back to return to the previous Web page. If enabled, 
the user can click Request Exception to request that the administrator allow access to this site. Also note the 
ñSubmit feedback to Net Nannyò link. Clicking this link takes the user to an Accuracy Feedback page on the Net 
Nanny Web site which provides a form the user can complete and submit to ContentWatch if they feel the filtered 
Web site is incorrectly categorized. 

If a user has override privileges, Net Nanny allows the user to override blocked content. The user can click 
Override to enter the override password and view the requested Web site. For some Web sites, the user might 
need to enter the override password more than once to view the content. 

Note: To give a user override privileges, you must select the Display Instant Override Messages option in the 
userôs Profile Settings. For more information, see Creating Individual User Profiles on page 35. 

Any of these actions is reported if reporting is enabled. For more information, see Enabling Local Reporting on 
page 70. 

Block or Warning Messages with Request Exception Option 

You can use Net Nanny to submit an exception request or display a blocked Web page. 

Submitting an Exception Request 

If a user has request exception privileges, Net Nanny lets the user submit requests to Net Nanny administrators 
to unblock or recategorize specific Web pages or entire Web sites that fall under a blocked or warning category. 

To submit an Exception Request, the user must perform the following in the Blocked or Warning dialog: 

1. Click Request Exception to display the exception or override request dialog. 

2. From the I think it should be drop-down list, select a suggested action (for example, allow the content 
or assign it to a new category). 

3. Click Send Request to submit the request to a queue in the Net Nanny Admin Tools, where a Net Nanny 
administrator can choose to accept or reject the request. 

For information on how Net Nanny administrators can process exception requests, see Processing User 
Exception Requests on page 69. 

Note: It is also possible to click Apply Now (instead of Send Request) to immediately unblock or 
recategorize the Web page or Web site. To apply the exception immediately, specify an administrative 
username and password when prompted. The filter settings are immediately updated for the user 
currently logged in to Net Nanny. The next time the user visits the Web page or Web site, the new 
settings are in effect.   
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To give a user exception request privileges, you must select the Allow user to request exceptions option in 
the userôs profile settings. For more information, see Creating Individual User Profiles on page 35. 

The action is reported if activity reporting is enabled. For more information, see Enabling Local Reporting on 
page 70. 

Displaying a Blocked Web Page 

To configure Net Nanny to display a generic ñHTTP 403 Forbiddenò Web page when a user is blocked from 
viewing a Web site: 

1. Sign in to the Admin Tools. 

2. From the User List, select an existing user profile, then click Filtering.  

3. In the When Blocked or Warned section on the Web tab, select ñForbiddenò page from the Display 
drop-down list. 

 

4. Click OK. 

 
Following is an example of the ñHTTP 403 Forbiddenò Web page that is displayed: 
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Redirecting a User to a Different Web Site 

To configure Net Nanny to redirect users to a Web site you specify: 

1. Sign in to the Admin Tools. 

2. From the User List, select an existing user profile, then click Filtering.  

3. In the When Blocked or Warned section on the Web tab, select Website from the Display drop-down 
list. 

  

4.  In the accompanying field, type the URL of the Web site where you want to redirect the user. 

5. Click OK. 

Configuring Filter Settings for Instant Messaging 

The Instant Messaging tab contains a number of settings that help you control and monitor a userôs instant 
messaging activities. You can choose to record instant messages, choose which instant messenger types to 
allow, and choose what types of instant messaging content to monitor. 
 
To configure Net Nanny to monitor instant messaging: 
 

1. Sign in to the Admin Tools. 

2. From the User List, select an existing user profile, then click Filtering.  

3. Click the Instant Messaging tab.  
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4. If you want to keep a record of all instant messages, select Record Instant Messaging activity. 

5. If you do not want to restrict the instant messaging programs the user is allowed to use, select All 
Instant Messenger types. 

Or, you can limit the instant messaging programs the user can use by deselecting All Instant 
Messenger types and selecting only the instant messaging types you want to allow.  

6. If you want to monitor instant messages for specific types of content, select Enable Instant Message 
Monitoring, then select the content categories you want to monitor. 

To monitor all content categories, select All categories. 

Or, select only those categories you want to monitor from the following available categories: 
 

Category Description 

Age Related Messages for discussions that include age-related questions and preferences, such as 
ñAm I too old for you?ò 

Camera/Pictures All messages for conversations that include trading or viewing of pictures or Web camera 
images, such as ñCan I see your pix?ò 

Direct Contact Conversations that include physical location or whereabouts, such as "Lets meet at my 
house." 

Direct Threats Messages for threats or descriptions of physical harm. 

Flirting Conversations that include flirtatious behavior, such as kissing or statements like ñYouôre 
sexy.ò 

Hurtful Language Conversations that contain mean or cruel language, including racial slurs or statements 
such as ñYouôre ugly,ò or ñYouôre stupid.ò 

Indirect Contact  Conversations that include alternative contact information, such as email address, phone 
number, IM contact names, etc. 

Personal 
Information 

Messages for personal information, such as age, sex, or location. 

Profanity  Messages that contain expletives or other offensive language, such as cursing or insults. 

Risk Assessment Conversations that include questions or messages about risky behavior, such as  "Are 
you home alone?" 

Sexual Content Conversation that include suggestive or sexually explicit content, such as references to 
sexual acts or body parts. 

Social Networking Conversations that include links to personal Web sites or social networking profiles, such 
as "Visit www.myspace.com/MyName." 
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Configuring Filter Settings for Social Networking 

Net Nanny lets you capture the social networking profiles of users who log in to social networking Web sites such 
as Facebook, Twitter, YouTube, and so on. Capturing these profiles enables you to see how users are 
representing themselves on the social network. 

For example, a parent may want to make sure that their child isnôt posting inappropriate pictures to Facebook. 
Net Nannyôs social networking report shows the pictures that the child has posted to their profile. The parent may 
also want to know who the childôs Facebook or other social network friends are. The social networking report 
allows the parent to see the childôs friends and their public profile pictures. 

The type and amount of social networking profile information that Net Nanny captures depends on the social 
networking site and how much information the user has provided in the profile. 

If profile reporting is enabled, Net Nanny captures profile information when the user logs in to the social 
networking site.  

When a user logs in to their social network account, Net Nanny requires the user to authorize Net Nanny to run in 
the context of the user's account on that site. If the user chooses not to authorize Net Nanny, access to the site is 
denied. 

 
 
 
To configure Net Nanny to capture profile information for social networking sites: 

1. Sign in to the Admin Tools. 

2. From the User List, select an existing user profile, then click Filtering. 

3. Click the Social Networking tab. 

4. If you want to capture user profiles for all supported social networking sites, select Select all Social 
Networking types. 

Or, you can limit which profiles Net Nanny captures by deselecting Select all Social Networking types 
and selecting only the social networking sites you are concerned about. 
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Note that when you capture a profile, you have up to 24 hours to view its associated report before the 
reportôs data is deleted. This restriction, which is required by the ñterms of useò agreements of certain 
social networking sites, has no effect if a user logs in to their social networking site account more than 
once during a 24-hour period. In other words, each time a user logs in to their account, the 24-hour 
countdown is restarted. 

5. To configure Net Nanny to send you an email when a social networking profile report has been created 
for a user, click the Set up an email alert to notify me when a profile is available for viewing link, 
then create a Social Networking email notification that is triggered when new profile data becomes 
available. For more information on configuring email notifications, see Configuring_Email_Notifications 
on page 79.  

6. To prevent users from logging in to social networking sites for which Net Nanny cannot capture user 
profiles, select Block unsupported social network sites. 

Configuring Additional Settings 

Net Nanny lets you control users' access to chat rooms, newsgroups, and peer-to-peer services. You can also 
choose how to handle content from secure Web pages (those pages that use the HTTPS protocol), control 
Internet access for 64-bit applications, block posts to blogs and forums, and control the viewing of remote 
reports. These items can be individually allowed or blocked for each user in the User List. 

 
 
To manage a userôs additional settings: 

1. Sign in to the Admin Tools. 

2. From the User List, select an existing user profile, then click Filtering. 

3. Click the Additional Settings tab. 
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4. Under Allow Access To, select the services you want the user to be able to access. 

Service Category Target Services 

Chat Rooms Chat clients or Web-based chat rooms that use the IRC (Internet Relay 
Chat) protocol 

Newsgroups NNTP (standard newsgroups) 

Peer-To-Peer Gnutella, BitTorrent*, Kazaa*, eMule*, and eDonkey* 

5. Under Secure Internet Content (HTTPS), select either Filter Secure Content or Allow secure content. 

If you select Filter Secure Content, you can also choose to Block secure content from unsupported 
applications.  

Unsupported applications include applications whose SSL implementation Net Nanny does not support. 
Currently, the only SSL applications that Net Nanny supports are browsers. If a user selects the Block 
secure content from unsupported applications setting, Net Nanny blocks any SSL application that is 
not supported, including non-browser applications such as QuickBooks and others.  

Enabling this setting might cause unintended side effects with some of your applications. 

6. Under 64-bit Applications, choose whether to Block Internet access for 64-bit applications. 

At present, Net Nanny cannot analyze or filter traffic from 64-bit applications, including 64-bit browsers 
Therefore, if you are running 64-bit applications on a 64-bit version of Windows, your only option is to 
have Net Nanny either allow or block Internet access for all your 64-bit applications. 

If you decide to block Internet access for 64-bit applications, you can select the option Display instant 
override option for 64-bit applications, which enables you enter the Net Nanny administrator 
password to bypass the block dialog. 

7. Under Forums and Blogs, you can control whether users are allowed to add text entries on forum and 
blog Web sites, and whether they can upload pictures to these sites. The available options are Block 
forum posts, Block blog posts, and Block uploading images. 

8. Under Remote Reporting, you can choose to Allow remote viewing of reports on the Net Nanny 
Remote Administration Web site. 

9. When finished, click OK to apply your settings.  
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 Managing Time Controls 
 
 

Time Controls allow you to manage the time of day and the amount of time that each user spends on the Internet. 
Each day of the week is divided into 30-minute time intervals that can be set to allow (green) or block (red) Internet 
access.  

 

The time controls show either a 12-hour clock (shown above) or a 24-hour clock, depending on your Windows 
settings. To change the way the time displays, change your Windows time settings. 

By default, Internet access is allowed at all times. If you define a Time Control for a user, the restriction applies to 
all Internet activity such as Internet surfing, instant messaging, newsgroups, peer-to-peer, and network gaming. 

Note: To ensure that Time Controls are enforced at the times you expect, verify that you have configured Net 
NannyÊ with the correct time zone for your location. For instructions on setting the time zone in the Net Nanny 
Admin Tools, see Setting the Time Zone on page 33. 
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Defining Time Controls 

To define user Time Controls:  

1. Sign in to the Admin Tools. 

2. Select a user profile from the User List, then click Time Controls. 

3. In the Time Schedule grid, click-and-drag to apply the control to a specific time frame. 

If you click-and-drag over a green space, that space changes to red. Likewise, clicking-and-dragging 
over a red space changes the space to green. A red space indicates Internet access is not allowed 
during the corresponding time of day, while a green space indicates that Internet access is allowed. 

4. To apply blanket settings, do one of the following: 

 Click Reset All to Allow to remove all ñBlockò time controls and allow Internet access at all times. 

 Click Reset All to Block to completely block Internet access. 

5. To limit the total number of hours a user can spend on the Internet over a given period, regardless of the 
controls that have been specified in the time grid, do the following: 

a. Under Time Allowance, select Allow. 

b. In the field to the right of the Allow check box, specify the number of hours the user is allowed to 
access the Internet. 

c. From the Hours Per drop-down menu, select the period (Day or Week) that the specified amount of 
hours applies to. 

6. When finished, click OK to apply your changes.  

Enforcing Time Controls 

When a time control is in effect, Net Nanny displays a message when the user attempts to access the Internet. 

If a user has override privileges, two options are available for overriding the time control. The user can: 

 Click Override and enter the override password to override the blocked connection. 
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 Right-click the Net Nanny systray icon and select Extend Time. (Note that this option is only available if 
the Time Allowance setting is enabled for the user.) 

  

The password used to override time restrictions is the same password used to override a blocked Web site. 

Note: To give a user override privileges, you must select the Display instant override option setting in the 
userôs Profile Settings. For more information, see Creating Individual User Profiles on page 35. 

If the user overrides the time control, Internet access is allowed for the duration of that browser session. If the 
browser is closed, the user must override the blocked connection again when attempting to access the Internet 
during a restricted time. 
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 Managing Games 
 
 

Net NannyÊ can block access to games with certain ratings or that contain elements that you do not approve of. 

1. Sign in to the Admin Tools. 

2. Select a user profile from the User List, then click Games. 

The Games screen for the chosen user opens: 

 

3. To determine which game ratings are allowed and not allowed, verify that the Enable game 
management for all users option is selected, then move the Ratings slider to the right or the left. 

 

Allowed ratings show in green, and disallowed ratings are red. 
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4. To block games that contain certain types of content, select the unapproved content descriptors from the 
Descriptors list. 

 

5. To allow or disallow any of the games in the Games list, click a game title to toggle between blocked 
(red) and allowed (green). 

 

6. If you prefer, you can block or allow all games in the list by clicking Reset All to Allow or Reset All to 
Block. 

7. Click OK when you have finished specifying your games settings.  

Note: In addition to the games listed here, Net Nanny can often discover other games that users attempt to play. 
If a game is discovered that is not on the default list, the new game is added to the list and is blocked or allowed 
based on the gameôs current ESRB and descriptor settings. 

Note: If a user has override privileges and chooses to override a game block, the game must be restarted before 
it can be played. 
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 Managing System Passwords 
 
 

The override password is used to override blocked content. Any user or administrator with override privileges 
must enter the override password to override blocked content. 

The uninstall password is required to uninstall Net NannyÊ.  

Changing the Override Password 

There is only one override password. Therefore, if the administrator changes the override password, it is 
changed for everyone with override privileges. 

To change the override password: 

1. Sign in to the Admin Tools. 

2. Under Family Settings, click Passwords. 

3. Under Block Override, type and confirm the new password. 

 

Passwords are case sensitive and must be between 3 and 13 characters in length. Numbers and letters 
can be combined. 

4. Click OK to save your changes. 

Important: After you change the override password, you must distribute the new password to all users who have 
override privileges. 
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Changing the Uninstall Password 

To change the uninstall password: 

1. Sign in to the Admin Tools. 

2. Under Family Settings, click Passwords. 

3. Under Uninstall, type and confirm the new password.  

 

Passwords are case sensitive and must be between 3 and 13 characters in length. Numbers and letters 
can be combined. 

4. Click OK to save your changes. 
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 Working with Exceptions 
 
 

Exceptions enable you to allow or block access to Web sites and applications that would normally be blocked or 
allowed. For example, if you have configured news sites to be blocked but want to allow access to CNN, you can 
create an exception that allows users to visit the CNN Web site.  

Creating Web Address Exceptions 

When a user enters a URL address in the browser, Net NannyÊ processes the requested page to determine 
which content categories it belongs to. However, the administrator can bypass this default process by manually 
allowing or blocking a specific site, or the administrator can assign a URL to a predefined content category so the 
filter settings (Allow, Warn, or Block) for that category are then applied to the Web site. 

Note: See Content Categories on page 45 for a list of the predefined content categories. 

To illustrate this point, let's consider the following example: 

Many Web sites contain educational articles that deal with the problems caused by pornography (and which, 
therefore, contain some adult content). Net Nanny might block this site as Pornography. After going to the site 
and examining the content, you might determine it is not pornography and may wish to allow this site. 

Let's assume you want to categorize the URL www.contentwatch.com under Family Resources. In the Website 
field, type the URL www.contentwatch.com. From the Action drop-down list, select Family Resources. 

Note: To be sure that this site is allowed under Family Resources, the administrator must go to Filter Settings 
under each userôs settings and make sure that Family Resources is set to Allow.  
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The site is now categorized as a Family Resources site and access is allowed.  

You can use an asterisk (*) as a wildcard when creating exceptions. The asterisk represents one or more 
characters. For example, if you create *.google.* as an exception, it would match all of the following Web sites: 

 http://www.google.com 

 http://images.google.com 

 http://www.google.net 

 http://video.google.com/foo/bar 

Likewise, *playboy* matches any URL that contains the word 'playboy' anywhere in the URL, including: 

 http://www.playboy.com 

 http://www.playboy.com/stories/page1.html 

 http://www.somesite.com/pics/playboy/pic1.jpg 

 http://www.somesite.com/pictures/show.cgi?image_source=playboy&img_number=123 

Warning: If an administrator creates a Web exception, Net Nanny will no longer analyze or filter that Web site. 
This means that if the site content changes, Net Nanny cannot determine its category. Therefore, use this feature 
with care. 
 
To create an exception for a Web address: 

1. Sign in to the Admin Tools. 

2. Under Family Settings, click Exceptions. 

3. Click the Web tab. 

4. Click Add. 

5. In the Website field, type the URL you want to override. 

 



 

 

ContentWatc h, Inc. / Net Nanny User Guide  
       Page 66 

Note: You can copy the URL from the browser and paste it in the Website field for accuracy. 

6. From the Action drop-down menu, you can do any of the following:  

 Select Allow to always allow the site.  

 Select Block to always block the site.  

 Select a content category to apply to the site.  

Note: The content categoryôs Filter Settings apply to the site. 

The URL is added to the list with its availability or category listed under Action. 

7. Click OK to close the Exceptions window. 

Creating Application Exceptions 

The Net Nanny application exceptions feature helps you work around conflicts that might arise between Net 
Nanny and other Internet-enabled software on your system. For example, Net Nanny might block some 
applications that require Internet access, such as personal finance software. You can create exceptions for such 
applications so that Net Nanny does not interfere with them when they try to access the Internet. 

To create an exception for an application: 

1. Sign in to the Admin Tools. 

2. Under Family Settings, click Exceptions. 

3. Click the Applications tab. 
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4. Click Add. 

5. Choose one of the following methods to select the exception application: 

Method 1: Select the application from a list of registered executables. 

a. Click Select from installed applications. 

b. Select the desired executable, then click OK. 

 

The selected executable is added immediately to the application exceptions list. 
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Method 2: Manually browse to the application executable. 

a. Select Custom application. 

b. Click Browse. 

c. Browse to the location of the applicationôs executable file (filename.exe) on your computerôs hard 
drive. 

d. Select the file, then click Open. 

 
 
e. When the executableôs name appears in the Custom application field, click OK to add the 

application to the exceptions list. 

6. (Optional) Remove an applicationôs exception. 

a. From the application exceptions list, select the exception you want to remove. 

b. Click Delete. 

7. When you finish adding and removing application exceptions, click OK to close the Exceptions 
screen. 
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Processing User Exception Requests 

Users who have been granted exception request privileges can submit requests to Net Nanny administrators to 
unblock or recategorize specific Web pages or entire Web sites that fall under a blocked or warning category. An 
administrator can review these requests in the Net Nanny Admin Tools (on the Requests tab of the Exceptions 
window) and decide on a case-by-case basis which requests to accept or reject. 

To process usersô exception requests: 

1. Sign in to the Admin Tools. 

2. Under Family Settings, click Exceptions. 

3. Click the Requests tab. 

  
 

4. Review the details of requests in the list. 

You can click the hyperlinks in the Web Address column to open requested Web sites in a browser and 
review their content. Also, before accepting a request, you can change the action or category the user 
has requested by selecting a different option from the appropriate Requested Action drop-down menu. 

5. Click the request. 

6. Click Accept Selected or Reject Selected, then click OK. 
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 Generating Usage Reports 
 
 

Two different reporting options are provided with Net NannyÊ: 

 Local, reports are located on the computer where Net Nanny is installed. You can view these reports to 
see Internet activity on the local computer.  

 Web-based reports are available from the ContentWatchÊ Web site. Web reports give the administrator 
the ability to check the content that is viewed on all computers where Net Nanny is installed.  

Enabling Local Reporting 

Net Nanny can report Internet usage for the entire system or for individual users. It retains activity data on the 
local computer for up to 30 days. To view individual user reports, reporting must be enabled for each user. To 
enable the reporting options for a user: 

1. Sign in to the Admin Tools. 

2. From the User List, select an existing user profile, then click Filtering.  

3. On the Web tab, select Record Web activity. 

4. On the Instant Messaging tab, select Record Instant Messaging activity. 

5. Click OK to save your changes.  

Accessing Local Reporting 

Net Nanny provides comprehensive local reporting for Web activity, instant messaging, and social networking. 
Each chart has drill-down capability to view transaction detail. Local reports are accessible to the administrator 
on the computer where Net Nanny is installed. 

Accessing Local Web Activity Reports 

Local Web reports display Web activity for administrators and users on the local system. You must generate local 
Web reports on the computer where Net Nanny is installed. 

Important: To view individual user reports, the Record Web activity option must be selected in the userôs Filter 
Settings menu. Also, you must have the Adobe* Flash* Player installed to view the reports. You can download it 
from http://get.adobe.com/flashplayer. 
 
To access local Web activity reports: 

1. Sign in to the Admin Tools. 

2. Under Family Settings, click Reports. 

3. From the Report On drop-down list, select Web Activity. 
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4. In the Date Range selector, select a pre-configured date range or specify a custom date range, then 
click OK.  

 

Net Nanny displays report graphs with drill-down capability for the following categories: 

 Web Activity 

 Web Searches 

 Instant Message Activity 

 Instant Message Alerts 

 Social Networking Profiles 

 

5. To drill down into the report data, such as activity by user and URLs visited, left-click a graphic element 
or a link in the report. 
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Accessing Web Search Reports  

Web search reports allow the administrator to view Web searches users have performed. 

Important: To view individual user reports, the Record Web activity option must be selected in the userôs Filter 
Settings menu. Also, you must have the Adobe Flash Player installed to view the reports. You can download it 
from http://get.adobe.com/flashplayer. 

To access local instant message reports: 

1. Sign in to the Admin Tools. 

2. Click Reports. 

3. From the Report On drop-down list, select Web Searches. 

  
 
4. In the Date Range selector, select a pre-configured date range or specify a custom date range, then 

click OK.  

  

 

A graph of Web searches performed within the selected time range is displayed. 
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5. To drill-down to the details of the search activity, click the graph. 

The exact search terms that were used to perform the search are displayed, along with the type of 
search, the search engine used, categories associated with the search terms, and the time the search 
was performed. 

 

6. To view the results of the search as they would appear to the user, click a search term. The results are 
displayed in a Web browser. 

 

 

Accessing Local Instant Message Reports  

Instant message reports allow the administrator to view the content as well as the time spent on instant 
messaging activities for administrators and users on the local system. You can also view a list of instant 
messaging alerts sent when a userôs messages contain questionable content. 

Important: To view individual user reports, the Record Web activity option must be selected in the userôs Filter 
Settings menu. Also, you must have the Adobe Flash Player installed to view the reports. You can download it 
from http://get.adobe.com/flashplayer. 

To access local instant message reports: 

1. Sign in to the Admin Tools. 

2. Click Reports. 

3. From the Report On drop-down list, select Instant Message Activity or Instant Message Alerts. 

  
 






































































